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What to Expect With This Manual 
This manual takes you through the initial one-time set up for integration of TimeClick® with your QuickBooks® 

Pro for Windows. Once set up, the integration is simple.  For further assistance there are additional resources. 

Compatibility 
Designed for QuickBooks® Pro for Windows, 2015 and later. 

Disclaimer: TimeClick software is designed to effectively import employee time data to multiple payroll software 

programs. However, successful importation is not guaranteed due to possible unforeseen circumstances or 

changes within those programs, which cannot be accounted for by Hawkeye Technology LLC. 

Resources Found on Website and Blog 
You can find additional documentation such as the FAQs page and Video Tutorials on our website. 

Our blog is another great resource for tips with the software and documentation on using advanced features. 

TimeClick Blog Features: http://www.timeclick.com/blog/category/timeclick-features/  

TimeClick Blog Technical Support: http://www.timeclick.com/blog/category/technical-support/  

Contact Customer Support Team 
Our support team is happy to assist. Contact them by emailing support@timeclick.com or calling (435)753-4102. 

Live chat is available through our website at timeclick.com. 

Initial TimeClick Set Up 
The initial TimeClick and QuickBooks® setup will only need to be completed once. 

Allow Data Extraction 
Log in to the Administration Mode; choose Preferences and then Password and Misc Controls. 

 

Check the box that reads Create Data Extraction File. This will allow TimeClick to create the files used in the 

QuickBooks® import. Click Finished and Finished again go back to the Administration Options Screen. 

http://www.timeclick.com/tc/faq.php
http://www.timeclick.com/tc/support-videos.php
http://www.timeclick.com/blog/category/timeclick-features/
http://www.timeclick.com/blog/category/technical-support/
mailto:support@timeclick.com
http://www.timeclick.com/


4 
 

Make Employees Eligible 
Now ensure that your all employees are eligible for all the different types of hours 

you want to import into QuickBooks®. 

Within the Administration Options choose Employees and then click Edit 

Employee Record. Then chose an employee and click on the Eligibility button. 

You will need to ensure that each employee is marked as eligible for any of the 

different hour types they will be using in TimeClick. Failure to do so will result in 

those hour types not appearing on the QuickBooks® import file. 

Note: Employees MUST be marked as Eligible for OT. Otherwise they will not 

appear on the integration report. By default on version LE 16 all new employees are 

marked as eligible for all the different hour types. 

When done, select Finished to navigate back to the Administrative Options 

window. 

Setup Report Preferences 
Within the Administration Options window select Report Preferences. 

 

 

Make sure that your overtime preferences are correct. If you have questions on how this is done please visit this 

blog post http://www.timeclick.com/blog/overtime-calculations-on-your-employee-time-clock-software/.   

The initial TimeClick setup has now been completed. 

 

 

 

http://www.timeclick.com/blog/overtime-calculations-on-your-employee-time-clock-software/


5 
 

Initial QuickBooks® Setup 
Before you create the QuickBooks® Import you will need to set up QuickBooks® to allow tracking of employee 

time data. 

Enable Time Tracking 
Go to the Edit menu on the top tool bar. Select Preferences, then scroll down and choose Time & Expenses. 

Click the Company Preferences tab, select Yes under Do You Track Time?, and click Ok to save the selection.  

 

Enable Employee Time Data 
Click on the Employees menu on the top tool bar and select Employee Center. Select an employee by double 

clicking on their name and then choose the Payroll Info tab. Check the box that reads Use time data to create 

paychecks. You will need to do this for each employee whose time you want to import. Once you are done close 

the employee center. 
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Export Timer List File 
Go to the File menu and select Utilities, Export, and then Timer Lists. Choose to save the file.  

Note: The file type must remain .IIF 
Note: Be sure to remember where you saved the file as you will need this file later. 

 

Export Employee List 
Go to File and choose Utilities, Export, and then Lists to IIF Files. Choose to save the file. 

 

Check the Employee List box and Click OK to save the file.  

Note: The file type must remain .IIF 
Note: Be sure to remember where you saved the file as you will need this file later. 
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Export Payroll Items 
Go to the Reports menu and choose List, then Payroll Item Listing. 

 

Click the Excel button, and then select Create New Worksheet.  

 

On the next window select Create a comma separate values (.csv) file,  select Export and save the file.  

Note: The file type must remain .CSV 
Note: Be sure to remember where you saved the file as you will need this file later. 

 

The initial QuickBooks® setup has now been completed. 
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Create an Online Payroll Integration Center Account 
After purchasing TimeClick you’ll receive an email with a link to create 

a password for your Online Payroll Integration Center account. Use 

this link to create your password.  

If you haven’t purchased TimeClick or you’re upgrading from an older 

version then you’ll need to manually create an account. Go to 

https://www.timeclick.com/payroll/log-in and select Don’t have an 

account? Fill out the form provided to create your account.  

Note: If you have previously created an online account you will not 

need to recreate one. 

Utilizing the Online Payroll Integration Center 

Upload QuickBooks® Files 
You will now need to upload the Timer Lists, Payroll Items and Employee List files that were exported from 

QuickBooks®. Once those files have been uploaded click Next. 

Note: Once you have uploaded these files they will remain associated your account, but you can change or re-

upload at anytime.  

 

Match TimeClick Hours with QuickBooks® Payroll Items 
Because QuickBooks® utilizes user-created payroll items you will need to match the QuickBooks® payroll items 

to TimeClick’s hour codes. For example, overtime hours in TimeClick need to be matched to your overtime 

payroll item in QuickBooks®. Select Not Used for TimeClick items that you don’t use.  Click Save and then Next. 

Note: Unless you start using different QuickBooks® or TimeClick items you will not be required to match the items 

again. 

https://www.timeclick.com/payroll/log-in
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Upload Employee Hours 
Now you will need to upload the TimeClick report for the pay period you would like to import into QuickBooks®. 

Running the Payroll Integration Report 
Note: This next part is done within TimeClick 

The Payroll Integration Report will be run at the end of each pay period to create the import file. To run this 

report, go to the Reports button in the Administration Mode and select Payroll Integration. 

 

On the screen that appears you will need to enter the beginning and ending dates of your pay period. By default 

this report will be run for all departments. If you would like to perform the import for a single department you 

can do so by clicking the Select Department button.  Once you are ready click the Accept button.  

 

The report will appear very similar to the other reports within TimeClick. Verify that the employee hours and 

overtime are correct and that no errors appear on the report. If there are duplicate entry errors or eligibility 

errors they will need to be resolved (See Common Errors), and then report must be run again to ensure 

accuracy. Once you are sure all the employees are included and their times are accurate close the report 

window. 
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Upload the TimeClick Report 
Return to the Online Payroll Integration Center. 

After running the Payroll Integration Report an export file was created in the program files for TimeClick under a 

folder called Payroll_Exports. 

Note: the default location for TimeClick is C:/Program Files/Hawkeye Technology Inc/TimeClick 

 

Click the Upload TimeClick Report button and browse to the Payroll_Exports folder and upload the 

TC_Payroll_integration_Import.csv file. 

 

Match Employee Names 
After uploading the TimeClick report you will be directed to a screen to match the employee names from 

TimeClick with the employee names in QuickBooks®.  When you are done click Save then Done. 

Note: After doing this once you will not be required to do it again unless you add new employees or change an 

employee’s name in QuickBooks®. 
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Generate and Download QuickBooks Import 
You will be directed back to the previous screen to generate your import file. Click the Generate QuickBooks® 

Import button. After you have generated the report the Download QuickBooks® Import button will turn blue 

and you can download and save the import file for QuickBooks®. Be sure to note where you save the file as you 

will need to import the file into QuickBooks®. 

 

Importing .IIF file into QuickBooks® 
Go to the File menu of QuickBooks® and choose Utilities, Import and then Timer Activities.  Choose the .IIF file 

you saved from the Online Payroll Integration Center. 

 

The following window will appear meaning the import was completed successfully. You are not required to view 

the report but you can to verify what was imported.  
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Common Errors 

TimeClick Errors 

Employee Eligibility Error 
This error appears on the TimeClick 

reports. If an employee is ineligible for a 

type of hours they will need to be marked 

as eligible within their employee record. 

Instructions for doing this are found here.  

Duplicate Errors 
Duplicate errors appear on the TimeClick 

reports. They occur when an employee 

has multiple Clock In or Clock Out actions 

in a row. To resolve this issue you’ll need 

to use the Modify Times option to remove the extra Clock In/Out.  

QuickBooks® Errors 

Incorrect Company Error 
This error occurs when you upload the import file into QuickBooks®. The reason the error occurs is because 

QuickBooks® has run an update and changed your company ID number. In order to resolve this issue you need 

to upload a new timer list file from QuickBooks®. The instructions to do so are found here.  

 

 

Additional Resources 
Blog – http://www.timeclick.com/blog 

FAQ – http://www.timeclick.com/tc/faq.php 

Video Tutorials – http://www.timeclick.com/tc/video-tutorials.php  

YouTube Channel – https://www.youtube.com/user/TimeClockSoftware  

Payroll Integration - http://www.timeclick.com/payroll/  

License Agreement - http://www.timeclick.com/ht/terms_and_use.php 

Terms and Conditions - http://www.timeclick.com/ht/terms.php  

http://www.timeclick.com/blog
http://www.timeclick.com/tc/faq.php
http://www.timeclick.com/tc/video-tutorials.php
https://www.youtube.com/user/TimeClockSoftware
http://www.timeclick.com/payroll/
http://www.timeclick.com/ht/terms_and_use.php
http://www.timeclick.com/ht/terms.php
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Copyright Information 
© 1994 - 2016 Hawkeye Technology, LLC All rights reserved. Printed in the United States of America. 

This manual, as well as the software described in this manual, is furnished under license and may only be used 

or copied in accordance with the terms of such license. The information contained in this manual is furnished for 

informational use only, is subject to change without notice and should not be construed as a commitment from 

Hawkeye Technology, LLC aka Hawkeye Technology LLC (hereinafter called HET). HET assumes no responsibility 

or liability for errors or inaccuracies that may appear in this book or in the software. 

Except as permitted by license, no part of this publication may be reproduced, stored in a retrieval system, or 

transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior 

written permission of HET. 

Companies, names, and/or other data used in screens and sample output are fictitious, unless otherwise noted. 

TimeClick is a registered trademark of Hawkeye Technology, LLC. 

QuickBooks® is a registered trademark of Intuit, Inc. Hawkeye Technology LLC is not affiliated with Intuit, Inc. in 

any way. 

IBM is a registered trademark of International Business Machines, Inc. 

Novell and Netware are registered trademarks of Novell Inc. 

Windows and Windows XX are registered trademarks of Microsoft Inc. 

Pentium is a registered trademark of Intel Inc.   

Acrobat ® Reader copyright © 1987-2016 Adobe Systems Incorporated. All rights reserved. Adobe and Acrobat 

are trademarks of Adobe Systems Incorporated. 

Other brand or product names are trademarks or registered trademarks of their respective holders. 

HET and all distributors of HET products warrant to the original purchaser of TimeClick, that for a period of 30 

days, from the original date of purchase, that under normal conditions of use, the download media containing 

the TimeClick software will be free of defects in material and workmanship. Should a download become 

defective in this period, the distributor will replace it free of charge.   

If during this 30-day period, a defect in software should appear, you must notify the distributor in writing. Your 

sole right with respect to a defect in software will be the replacement of the software with the most current 

version available to the public. 

HET and all distributors also disclaim all liability as well as incidental and consequential damages which may 

result from the use of TimeClick and/or the hardware on which it has been installed, and/or as a result of 

operating TimeClick within the user's hardware and/or software environment.   

IN NO EVENT WILL HET OR ANY DISTRIBUTOR OF HET PRODUCTS BE LIABLE FOR ANY CONSEQUENTIAL, SPECIAL, 

INCIDENTAL, DIRECT, OR INDIRECT DAMAGES RESULTING FROM THE USE OF TIMECLICK AND THE PURCHASER 

WILL ASSUME ANY AND ALL COSTS RESULTING IN THE USE OR FAILURE OF THIS PRODUCT.   

YOUR RIGHTS VARY FROM STATE TO STATE 


